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Capture still images or record video.

7

Select small sizes to send captured
images/recorded video via S! Mail*;
select larger sizes for higher resolutions.

Measures the distance between
subjects and camera to adjust focus.

Apply effect or add frame, capture
sequential/panoramic or scan images.

Open/play last saved mobile camera file
quickly; access older files as needed.

*May not be delivered as sent depending on image/recording size or recipient device.

Precautions

® Clean dust/smudges from lens cover with
a soft cloth before use.

® Mobile camera is a precision instrument,
however, some pixels may appear
brighter or darker.

® Shooting/saving images while handset is
hot may affect the image quality.

® Subjecting the lens to direct sunlight will
damage the camera's color filter.

Auto Shut-off

® Before image capture/recording, mobile
camera shuts down after a period of
inactivity and handset returns to Standby.

Shutter Click

® Shutter click and Self-timer tone sound at
fixed volume regardless of handset settings.



Il video Viewfinder

Display Indicators

The following indicators appear at the top %
of Display. B BOw

. Photo Viewfinder _ e

s [00:00:00 DO00KB/ 1000KB

| Mobile Light H | Focus
HF | Video Quality [A | Exposure
H | Record Size Save to

B Vobie ight Foous [ | Record Time H | Sel-timer

F | Memory E | Exposure

H | Picture Quality |El| Save to

| Picture Size [l | White Balance

H | Continuous Shoot || Self-timer

[ | Scene

i
(% 2 Opening Help (P.7-15)

Camera
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Photo Camera

(¢] ® Camera » (] Frame image on Display # [¢] Sending Captured Images via S! Mail
After » Complete message »
D 4 150 ;
Photo Camera % E ity @ @ 0~ m After pressing [, message size

confirmation appears depending on
image size or handset settings; select
message size limit and press [e].
Images may be resized automatically.
® To make selection the default setting

hereafter, press [=] to check From now
on too check-box.

Sending Captured Images at High

TS5
B 0w ate

n‘? Speed via Infrared
3 0pti0 end After ), [] (Long) ® Yes » [e]
S | Image Save Window m Set recipient device to ready beforehand.
2 0 : o . .
g Photo Viewfinder ° f::;f;;'gi‘:r:”géh;;zﬁ:;ﬁs - H Pre-Image Capture Operations
e start over, press Zoom In/Out Vel
3 Toggle Mode
(o] Adjust Brightness kol
® Image is saved. (Viewfinder returns.) Change Image Size
® Open saved images via Review or Toggle Mobile Light Mode B
Data Folder. Open Help

® Camera shuts down

m @ Activating Mobile Light ¢ Adjusting brightness ¢ Adjusting focus quickly for close-up shots ¢ Changing shutter click sound © Changing image size
Changing mode according to lighting or subject ¢ Adjusting color balance according to lighting conditions (And more on P.7-15)




(¢] & Camera » [o] (] Playing Unsaved Video

] In ), Preview » (o]
Video Camera % [o] Sending Recorded Video via S! Mail
- In ), Send » [¢] ® Save and Send
® [¢] » Complete message »

® Message creation confirmation

T &
BE B

Video Save Menu appears depending on file size; choose
® Recording stops with a tone. (To Yes and press [#] to proceed. (Choose
discard file and start over, press No to cancel attachment.)
® To make selection the default setting
- Save » @ hereafter, press [=] to check From now o
% 00:00°00 D000K8/ 1000KB ® Video is saved. (Viewfinder returns.) on too check-box. ]
® Play saved video via Review, Data = May not be delivered as sent depending 2
Folder or Media Player. on recording size or recipient device. i
L0l o Incoming Calls
Video Viewfinder » Camera shuts down e|fa callgarrives before video is saved, g
Frame image on Display ® [¢] M Pre-Recording Operations tr:zoc:r:ﬁ?ocr"e‘;tif;emporar“y saved. End <
® Recording starts after a tone. (To Zoom In/Out )e] When Battery Runs Low @
start over, pres Toggle Mode ® Recording stops. (Recorded clip is saved.)
Adjust Brightness /o
Change Record Size ¢
Toggle Mobile Light Mode
Open Help
Kg? Activating Mobile Light ¢ Adjusting focus quickly for close-up shots (And more on P.7-15) m
Changing recording time/size © Enlarging Viewfinder size © Recording video without sound (And more on P.7-16)




Review
Opening Last Saved File Enlarging Images Sending Images

After ), [eo]
Open/play last saved mobile camera file; PausingIRe,suming Video Send images to blogs, etc. via mail.
access older files as needed. After &, [¢] (press repeatedly to Infrared and other options can also be
E] » Camera » B pause/resume) used for sending images to other devices.
Opening Help To send images to blogs, complete Blog
Review » [o] [Review Window] Setting beforehand.
. Accessing Older Files In Review file list, select
. . image »
In Review window, 9
o Send/Blog » [e]
3
)
o
[ . Blog Tool
§ LIS / Via Infrared
3 @ Via IC Transmission
5' MailArt
@
Options Zoon Ca of .
X2 ot Select option » [e]
Review Window e ® Follow onscreen instructions.
® To end Review, press [2]. Size' 018

Review File List

® File list appears; press [¥| repeatedly
to toggle lists.

Select file » [e]

® File opens/plays.




Shooting Modes

May be unavailable depending on selected image/recording size.

m Continuous Shoot (Photo Camera) (o]

In Photo/Video Viewfinder, Available Modes: All Pictures » (o]

» Self-timer » [o] 4 Pictures | C2Pture four separate ® All captured images are saved.
) images with Index Image Saving the Selected Image
Select time » [e] 9 Pictures | C2Pture nine separate After (), (o] (select image) ® [¢] &
T A 505G images with Index Image Selected Picture » (]
oBlE DN At~ Capture five images to create
: o Overlapped | czmposite ima%e Adding Frames (Photo Camera)
Frame image on Display ®» "
ge play In Photo Viewfinder, =] # In mode menu, Add Frame ~ Q
® After selected time elapses, captured » ‘EI 3
image appears or recording starts. Modes » E (]
® To stop recording, press [e]. o Add Frane Preset Frames » (@] ;
® For more, see operation descriptions i s
on P.7-4 or P.7-5. Tilid 150 §
Preset Frames «Q
Releasing Shutter during Countdown Mode M [ Frane 14 B
After ), ‘z' ode lVienu ] «Q
Incoming Calls/Alarm during Countdown Continuous Shoot » E]
® Countdown stops. (Self-timer remains
active.) Select mode ® [¢] » Select Select frame # [¢]

speed » (o] Frame image on Display ® [e]

Frame image on Display ® [e] ® Captured image appears. =~
. ® Press [#] to save image. (Viewfinder
® After image capture, Index Image or

a composite image appears. returns.)

® When shooting speed is set to Using Frames in Data Folder
Manual (4 Pictures and 9 Pictures In &, Data Folder » (o] ® Select
modes), repeat ) for each frame. frame » [o] » [o]
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Shooting Modes :
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Frame image on Display ® [e]

Camera Effects (Photo Camera)

In mode menu, Camera
Effects » (o]

Select effect # [o]
Frame image on Display » [e]

® Captured image appears.
® Press (@] to save image. (Viewfinder
returns.)

® Move handset slowly to keep 9F
aligned with either of yellow lines.
® |[mage is captured automatically

" hen the bar (===) turns blue.
Panorama Picture (Photo Camera) when the bar (=) turns blue

In mode menu, Panorama/
Scanner » [o]

Panorama Picture
i

Save Menu

Panorama/Scanner Menu

Panorama Picture & [e] »
Onw (o]

® Image is captured and Save menu
opens.

Save » (o]
® Image is saved.

Checking Unsaved Images
In ), Preview » [e]

Scanning Images (Photo Camera)

In Panorama/Scanner menu,
Scanner » o]

Select size ® [¢] » Frame
image on Display » [e]

® Move handset slowly to scan the
area to capture. (Refer to indicators
on Display.)

(o]

® Image is captured and Save menu
opens.

Save » o]

® |[mage is saved.

Checking Unsaved Images

In ©), Preview ®» [e]

@ Changing Panorama settings ¢ Changing Panorama image preview method (P.7-16)




Editing Images
Select effect # [¢] # Et

The following options are available. (o] & Data Folder » [e]
Some images may not be editable )
depending on file type and size. Pictures % [¢] ®» Select
. Select from preset sizes or Image » E
pesie crop image » Edit » E\
I
Frame Add Frame to images
Paste Add text/dates to images Picture Editor » [e] ® To start over, pres
Retouch Dress up images with T T When finished,
preloaded visual effects x _ 9
Stamp Add stamps to images g
Make smiley, angry or sad Save as New S
Face Arrange | ¥, angry TG :
Correction Correct.images Save as New » E §
Rotate Rotate |rn-ages besiae ® To overwrite, select Overwrite and ‘g
File Format Convert f."e fprmat and Ll e press [®]. (Omit ©).) «
change file size
Enter name » [¢] » Save
Picture Editor Menu here % @

Canceling Effects
After ), Undo » [e]
® To restore effect immediately after
canceling, select Redo and press [®].




—1 Editing Imag f
Changing Image Size @ Specify display area Il cropping images
Select from preset sizes or crop image. 3 o In Resize window, Cut » [e]

. Resize to Preset Size 9 Move + to the upper left
In Picture Editor menu, corner of the portion to crop
Resize % (o] »

Resize

Wal Ipaper

Power On/0ff
Incoming Call

Alarm Ut

Resize Window
g @ Select size » [o] ° Qmit@ if there is no rectangle on the =
2 image. @ Move + to the lower right
> @ [o] corner of the portion to crop
) ® Editing is completed. » E’
& Zooming In/Out E]
a Atter ©, 2] » [O] & ©)

® Editing is completed.
Specifying Display Area
After ), [ » ©)

Zooming In/Out
After ©, =] &[] » ©)

o] I Advanced |

é@ Using additional editing options (P.7-16 - 7-17)

7-10



Editing Images I—

Applying Visual Effects Adding Frames

Render in sepia tones or add blur, etc. In Picture Editor menu,
In Picture Editor menu, Frame » [e]
Retouch » [e]

Retouch

Sparkl ing
Ripples
Tile

Buibew) B elawe) i

@ B E ® Editing is completed.

® Editing is completed.

7-11



Editing Imag [
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Make faces smiley, sad, etc.

In Picture Editor menu, Face
Arrange » (o]

Face Arrange
Col lage:Right-hal f
Col lage:Left-hal f

Face Arrange Menu
Select type » [9]
(o]

® Editing is completed.

Important Face Arrange Usage Note

® When using Face Arrange, take care not
to create images that may embarrass or
offend others. Always obtain permission
before photographing others.

. Adjusting Positions

Change the default positions and sizes of
targets to fit the image.

In Face Arrange menu, = B

® A rectangle appears with + in the
upper left corner.

Move + to top left of face
»

Move + to bottom right of
face

FaceLine

(o]

® Face line is set. Set the eyes and
then mouth in the same way.

(o] » Yes » [¢] & Save
here » [e]

® |[mage is saved as a new entry with
Face Arrange positions adjusted.
Complete Face Arrange. Face
Arrange is applied to the adjusted
positions.



: Editing Images I—
Composite Options Merge Panorama % [e] When finished,

The following options are available. LTS b
Some images may not be editable
depending on file type and size.

Combine up to

Split Picture ) .
four images into one
Merge Panorama Qombing two sl Merge Panorama
images into one "1 XXXXXX_XXXXXX. ipg
& <Enpty>
o
Panorama Image Effects: ® ' (] 3
Near View | Best suiFed for clo§e-up shots ® File selected in & is set as left image. Enter name » [¢] » Save :
[S)oczme:t :selfor |miges with text <Empty> » El » Select here » E’ §
tandar: to other images :
pPly 9 Image » B Changing Images ‘g
After ©, select image » » = B Q
E’ ®» Data Folder » E’ EFFECT » E » Select P E9 (]
Pictures » [¢] B Select effect » [o] Switching Image Positions
image » E’ ® Editing is completed. After (),
» Edit » (o]

Composite » (]

5

é? Combining reduced images (P.7-17)
7-13




For Each picture ] %
Select folder » [e]

Select images from Memory Card and
specify the number of copies to print on Select image »
DPOF-compatible printers, or at digital
printing services. )

DPOF settings made on other devices are ?ﬁ;ggg?'es of selected
unusable; delete existing settings to
create new ones on handset.

Images

(o] » Settings » [¢] » [ e
Connectivity 33 Copy
Memory Card » [¢] » o,

DPOF » [e]
Number of Copies » [e]

Til@ & @ 15:05
Number/Total:0

Enter a number of copies to
print » [e]

® For more settings, repeat =) -

Buibew| B elawe)

For Al Pictures | .
Y|

For Each Picture
Applying a Number to All Images
In ©), For All Pictures % [®] ® Enter
a number of copies to print » [e]
Canceling Specified Number
In ), enter 00 » (o] »
Viewing Current Print Settings
In ), Check Settings » (]

@ Changing print settings (P.7-17)

7-14



Photo Camera & Video Camera M Saving
Activating In Photo/Video Viewfinder, Settings = [e]
M General automatic saving Auto Save * [¢] © On
In Photo/Video Viewfinder, Help = (o] Changi In Photo/Video Viewfinder, Settings = [e]
Opening Help ® Press [v] to toggle Help window for key assignments an.glng save Save Pictures to or Save Videos to =[]
and indicator descriptions. location Select location (o]
M Capturing

Activating Mobile
Light

In Photo/Video Viewfinder, Mobile Light
[¢] =~ On or Automatic = [e]
® [ow Lightis also available for still image capture.
® Do not use Mobile Light near people's faces or look
into the light yourself.

Adjusting
brightness

In Photo/Video Viewfinder,
Settings or Record Settings
[¢] = Adjust level

Shooting
[e] = Exposure

Adjusting focus

In Photo/Video Viewfinder, (5] =~ Shooting

quickly for Settings or Record Settings * (] = Focus
close-up shots Setting © (] © Macro - [e]
In Photo/Video Viewfinder, Shooting
- Settings or Record Settings * (] = Focus
Adjusting focus 3
el Setting © [®] © Manual Focus = [e] = [2]

Adjust focus * [e]
® To readjust focus, press [2].

Locking focus

In Photo/Video Viewfinder,
® Frame subject in center of Display first.
® To start over, press again.

Changing image
quality

In Photo/Video Viewfinder, [=| * Picture Quality
or Video Quality © [®] © Select quality ~ [e]

M General

Changing shutter
click sound

In Photo Viewfinder, 2] © Settings = (]

Shutter Sound  [¢] - Select pattern = [e]

® Shutter click sounds for Continuous Shoot,
Panorama Picture and Scanner are fixed.

Hiding indicators

In Photo Viewfinder, Settings = (o]
Display Indicators - [®] - Hide Indicators - []

In Photo Viewfinder, [=] -~ Settings = [¢] = Set

Changing send Send Key - [®] - Short press or Long press
. ¥ [e] = Select option = [e]
n ned to |v/
RLONIESS ORetltS ® Change send option separately for each key press
method.
M Capturing

Changing image
size

In Photo Viewfinder, Picture Size - (o]
Select size = [o]

Changing mode

according to ';J:::‘;;’;Wfln&er, Scene - [e]
lighting or subject
Adjusting color In Photo Viewfinder, Shooting Settings

balance according to
lighting conditions

[®]  White Balance - [®] = Select mode ~ [®]

Additional Function

Buibew) B elawe)
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Additional Functions
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M Panorama Picture

7-16

Changing
Panorama settings

[Sartrere)in Photo Viewfinder, [=] » Settings »

[¢] ®» Panorama Settings % [¢] » See below M Picture Editor

Editing Images

Hiding Guides

Assisting Lines = [¢] © Off = [e]
Locking Display Brightness during Image Capture
AE-Lock ~ [®] © Enable (]

Changing
Panorama image
preview method

In Panorama preview, [] ** Manual Scroll or
Full Image + [°]

M Recording

Changing
recording time/size

Using additional

In Video Viewfinder, Record Time/Size " N
editing options

[®] © For Message or Extended Video  [e]
Select size = [¢]

Enlarging In Video Viewfinder, (5| © Display Size = [e]
Viewfinder size Enlarge = [e]

Recording video In Video Viewfinder, [=] Microphone - [e]
without sound off = [e]

(Startriere)[®| ® Data Folder ® (] % Pictures %
[o] ® Select file » [¢] » 5] » Edit » [¢] »
Picture Editor % (] » See below

Changing Text/Outline Color

Paste * [¢] = [5] = Select text color = [e]
[¢] © Select outline color * [e]
Adding Text

Paste * [®] © Free Text = [®] = Enter text

(o] = [ Move text = [e]

Adding Dates

Paste = [¢] = Date - [¢] = [ Move date = [®]

Adding Stamps
Stamp © [e]
stamp (o]

[o] = K4 Move

Select stamp

Correcting Image Parameters

Correction © [e] © Select type = [¢] = [e]

Rotating Images

Rotate  [¢] = Select type = [¢] = [o]

Converting File Format
File Format -~ [®]  File Format = [e]

Select format * [e]

® Changing file format may affect file size/image quality.
® To return to Picture Editor menu, press




Using additional
editing options

(StartHere] (| ® Data Folder % (o] » Pictures »
[¢] » Select file » (o] & [ & Edit» [¢] »
Picture Editor % [¢] » See below

Changing File Size
File Format - [®] * File Size © [¢] - Select
size = [o]

® Changing file size may affect image quality.
® To return to Picture Editor menu, press

H Composite

Combining
reduced images

(Startrere)(®] ® Data Folder » [¢] % Pictures %
(o] » Select file » [¢] » (=] & Edit & [¢] »
Composite % [¢] » See below

Creating Split Picture

SplitPicture 240x400 or SplitPicture 240x320
[¢] = <Empty>~ [o] - Select file = [o]

When finished, Enter name * [®] = Save
here - [e]

® Repeat from selecting <Empty> as needed.

Previewing Split Picture
While creating Split Picture, View
Composite = [e]

Changing Images
While creating Split Picture, select image (]
[# = Select another = [e]

Deleting Images
While creating Split Picture, select image
Remove © [®] = Yes ' [e]

| Additional Functions

I_

Changing print
settings

[Sarters) (] ® Settings #» (o] ® [ Connectivity
» Memory Card % [¢] » DPOF % [¢] » See
below

Adding Dates to Prints
Settings = [¢] = Add Date = [¢] = On ' [e]

Creating an Index Print
Settings  [®] = Index Print = [¢] =~ On ~ [e]

Resetting
Reset Settings © [¢] © Yes =[]

Buibew) B elawe)
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Troubleshooting
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Mobile Camera

Mobile camera won't activate/

shuts down automatically

® Battery may be low. Charge battery or
install a charged battery.

Cannot use Auto Save

® Auto Save is not available when Save
Pictures to is set to Ask Each Time.

Editing Images

Cannot save/send edited images

® Edited images may be too large to
save or send via mail.

Cannot specify print settings

properly

® |f Memory Card image files have been
deleted or renamed on PCs or other
devices, reset print settings and start
over with settings.
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